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Overview

Overview

Scenario Analysis 123 allows you to quickly create and iterate through several what-if scenarios
using different driver-based rules to analyze different outcomes. The solution lets you create and
manage rules and run calculation jobs across scenarios, and includes reporting capabilities so

YOu Ccan compare results across scenarios.

Important Usage Considerations

This topic identifies some considerations for best implementing and using Scenario Analysis 123.

Access

Scenario Analysis 123 is not intended for use in Workflows and must only be accessed using the

Community Solution dashboard. Limit usage of Scenario Analysis 123 to the following:
* Experienced OneStream “Power Users”
* Administrator security role

* Security group with a limited number of experienced “Power Users”

Performance Impacts

Scenario Analysis 123 is not intended for full Entity or multi-Entity hierarchy consolidations
spanning multiple periods or years for multiple users. Calculation jobs created using Force

Consolidate are intended for base level calculations and small consolidation hierarchies.
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Overview

The single environment shares resources between the two applications. Testing Scenario
Analysis 123 in a single environment that includes Development and Production applications will
impact both applications. Coordinate an optimal testing window within your organization to

prevent negative impact on other reporting processes performed in the Production application.

When copying base data from one scenario to another, it is important to understand how much
datais being copied and whether you need to consolidate the whole Entity structure or multiple
Entity structures. Multiple large consolidations in the system may impact each other depending

on the environment configuration.

Refer to the consolidation schedules of your organization before using Scenario Analysis 123.

Important Usage Considerations

This topic identifies some considerations for best implementing and using Scenario Analysis 123.

Access

Scenario Analysis 123 is not intended for use in Workflows and must only be accessed using the

Community Solution dashboard. Limit usage of Scenario Analysis 123 to the following:
* Experienced OneStream “Power Users”
* Administrator security role

* Security group with a limited number of experienced “Power Users”

Scenario Analysis 123 Guide 2



Overview

Performance Impacts

Scenario Analysis 123 is not intended for full Entity or multi-Entity hierarchy consolidations
spanning multiple periods or years for multiple users. Calculation jobs created using Force

Consolidate are intended for base level calculations and small consolidation hierarchies.

The single environment shares resources between the two applications. Testing Scenario
Analysis 123 in a single environment that includes Development and Production applications will
impact both applications. Coordinate an optimal testing window within your organization to

prevent negative impact on other reporting processes performed in the Production application.

When copying base data from one scenario to another, it is important to understand how much
datais being copied and whether you need to consolidate the whole Entity structure or multiple
Entity structures. Multiple large consolidations in the system may impact each other depending

on the environment configuration.

Refer to the consolidation schedules of your organization before using Scenario Analysis 123.

Important Usage Considerations

This topic identifies some considerations for best implementing and using Scenario Analysis 123.

Access

Scenario Analysis 123 is not intended for use in Workflows and must only be accessed using the

Community Solution dashboard. Limit usage of Scenario Analysis 123 to the following:
* Experienced OneStream “Power Users”

* Administrator security role
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* Security group with a limited number of experienced “Power Users”

Performance Impacts

Scenario Analysis 123 is not intended for full Entity or multi-Entity hierarchy consolidations
spanning multiple periods or years for multiple users. Calculation jobs created using Force

Consolidate are intended for base level calculations and small consolidation hierarchies.

The single environment shares resources between the two applications. Testing Scenario
Analysis 123 in a single environment that includes Development and Production applications will
impact both applications. Coordinate an optimal testing window within your organization to

prevent negative impact on other reporting processes performed in the Production application.

When copying base data from one scenario to another, it is important to understand how much
datais being copied and whether you need to consolidate the whole Entity structure or multiple
Entity structures. Multiple large consolidations in the system may impact each other depending

on the environment configuration.

Refer to the consolidation schedules of your organization before using Scenario Analysis 123.
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Setup and Installation

Setup and Installation

This section contains important details related to the planning, configuring, and installation of

your solution. Before you install the solution, familiarize yourself with these details.

See also: OneStream Solution Modification Considerations

Dependencies
Component Description
OneStream Minimum Platform version required to install this version of Scenario
5.3.0 or later Analysis 123.
OneStream Scenario Analysis 123 is optimized for the OneStream App for Windows
App for which has all the functionality as the browser-based version of
Windows OneStream.

Select the Scenario Analysis 123

Development Location

Before installation, decide whether to build the solution directly in the Production OneStream
application or in a separate Development OneStream application. This section provides some key

considerations for each option.
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Setup and Installation

Production OneStream Application: The primary advantage of building the solution in a
Production application is that you will not have to migrate the resulting work from a Development
application. However, there are intrinsic risks when making design changes to an application

used in a Production capacity and it is not advised.

NOTE: OneStream strongly recommmends that you implement the solution in the
Development environment with a fresh copy of the Production application before

starting work.

Development OneStream Application: As a best practice, use the Development OneStream

application to build the solution.

Create the OneStream Development
Application

1. Ensure all the OneStream artifacts relating to Scenario Analysis 123 such as scenarios are in

the Production application.

2. Copy your Production OneStream application to your Development environment and

rename it. This Development version will be used for your Scenario Analysis 123 project.

Application Server Settings

You may need to edit the OneStream Application Server Configuration so users can create and
change data in the additional database tables. If other OneStream Solutions (such as Specialty

Planning) are already in the application, these adjustments may already exist.

See also: Solution Database Migration Advice
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Configure the OneStream Application Server

Be sure that the security group settings include the users who work on and set up the solution

before proceeding.

NOTE: Group settings are applicable to all OneStream Solutions; it is important to

keep the group names generic.

1. Start the OneStream Server Configuration Utility as an Administrator.
2. Click Open Application Server Configuration File > Database.
3. Editthe following OneStream Database Server properties:

* Access Group for Ancillary Tables: Select a group that includes those who will access

records.
* Can Create Ancillary Tables: True
* Can Edit Ancillary Table Data: True

* Maintenance Group for Ancillary Tables: Select a group to edit and maintain tables.

Scenario Analysis 123 Guide
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* Table Creation Group for Ancillary Tables: Select a group who can create tables.

OneStream Database Server properties:

=]

» Azure Database Connection Settings

» Connection String Settings

~ General
Access Group for Ancillary Tables DB_ANC_A ,Group I
Allow Database Creation via Ul True
Can Create Ancillary Tables True
Can Edit Ancillary Table Data True
Database Provider Type SqlServer
ls External Database False
Maintenance Group for Ancillary Tables DB_ANC_Masintenance Group I"l_
Mame OneStream Database Server
Table Creation Group for Ancillary Tables Everyone
Use File Groups when Creating Databases True
Use Table Partitioning when Creating Databases True

4. RestartInternet Information Server.

Application Server Settings

You may need to edit the OneStream Application Server Configuration so users can create and
change data in the additional database tables. If other OneStream Solutions (such as Specialty

Planning) are already in the application, these adjustments may already exist.

See also: Solution Database Migration Advice

Configure the OneStream Application Server

Be sure that the security group settings include the users who work on and set up the solution

before proceeding.

NOTE: Group settings are applicable to all OneStream Solutions; it is important to

keep the group names generic.
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Setup and Installation

1. Start the OneStream Server Configuration Utility as an Administrator.

2. Click Open Application Server Configuration File > Database.

3. Edit the following OneStream Database Server properties:

* Access Group for Ancillary Tables: Select a group that includes those who will access

records.

* Can Create Ancillary Tables: True

e Can Edit Ancillary Table Data: True

* Maintenance Group for Ancillary Tables: Select a group to edit and maintain tables.

* Table Creation Group for Ancillary Tables: Select a group who can create tables.

IDES
#1212

OneStream Database Server properties:

4| &

>
>
b

Azure Database Connection Settings
Connection String Settings

General

Access Group for Ancillary Tables

Allow Database Creation via Ul

Can Create Ancillary Tables

Can Edit Ancillary Table Data

Database Provider Type

|s External Database

Maintenance Group for Ancillary Tables
Mame

Table Creation Group for Ancillary Tables
Use File Groups when Creating Databases
Use Table Partitioning when Creating Databases

[DB_ANC Access Grow J«———

True
True
True

SqlServer
[DB_ANC_Maintenance_Group | «————[ Read Access |

Ig_;-:'gm_[mmm_l

True
True

4. RestartInternet Information Server.
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Install Scenario Analysis 123

1. Inthe OneStream SolutionExchange, go to OneStream Solution > Scenario Analysis 123.

Scenario Analysis 123

2. Onthe Scenario Analysis 123 Solution page, select the appropriate Platform version from

Minimum Platform Version.
3. Selectthe mostrecent version from Solution Version and then click Download.
4. Loginto OneStream.
5. Click Application > Tools > Load/Extract.
6. OnLoad, locate the solution package using the Select File icons and click Open.
7. When the solution’s file name appears, click Load.

8. Click Close to complete the installation.

Set Up Scenario Analysis 123

The first time you run Scenario Analysis 123, you are guided through the table setup process.

* In OneStream, click Community Solution> Dashboards > Scenario Analysis 123 >

Scenario Analysis 123.
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= Workflow -
¥ Cube Views a

4 &% Scenario Analysis 123

| Scenario Analysis 123

Create Tables

1. Click Step 1: Create Tables

This step may be necessary when upgrading even if tables are already present. Scenario
Analysis 123 does not drop any tables that already exist but modifies table structures and

adds any new ones if necessary.

[ xPW_SAM_Calclabs
[ XFW_SAM_ControlLists
[ XPW_SAM_Definitions
[ XPW_SAM_Rules

[ XPW_SAM_RuleSets

2. Click Step 2: Launch Solution to open Scenario Analysis 123.

Package Contents

The Dashboard Maintenance Unit provides the user interface for Scenario Analysis 123 and

includes the required dashboard groups, components, data adapters, parameters and files.

Set Up Scenario Analysis 123

The first time you run Scenario Analysis 123, you are guided through the table setup process.

Scenario Analysis 123 Guide
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* In OneStream, click Community Solution> Dashboards > Scenario Analysis 123 >

Scenario Analysis 123.

OnePlace ~ B

= Workflow &

fF Cube Views -

4 &% Scenario Analysis 123

| Scenario Analysis 123

Create Tables

1. Click Step 1: Create Tables

This step may be necessary when upgrading even if tables are already present. Scenario

Analysis 123 does not drop any tables that already exist but modifies table structures and

adds any new ones if necessary.

[ HFW_SAM_Calclobs
[ XFPW_SAM_ControlLists
[ XPW_SAM_Definitions
[ XPW_SAM_Rules

[ xPW_SAM_RuleSets

2. Click Step 2: Launch Solution to open Scenario Analysis 123.

Package Contents

The Dashboard Maintenance Unit provides the user interface for Scenario Analysis 123 and

includes the required dashboard groups, components, data adapters, parameters and files.
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Set Up Scenario Analysis 123

The first time you run Scenario Analysis 123, you are guided through the table setup process.

* In OneStream, click Community Solution> Dashboards > Scenario Analysis 123 >

Scenario Analysis 123.

OnePlace * 8

= Workflow -

¥ Cube Views -

4 &% Scenario Analysis 123

|== Scenario Analysis 123

Create Tables

1. Click Step 1: Create Tables

This step may be necessary when upgrading even if tables are already present. Scenario
Analysis 123 does not drop any tables that already exist but modifies table structures and

adds any new ones if necessary.

[ xPW_SAM_Calclabs
[ XPW_SAM_ControlLists
[ XPW_SAM_Definitions
[ XPW_SAM_Rules

[ XPW_SAM_RuleSets

2. Click Step 2: Launch Solution to open Scenario Analysis 123.
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Package Contents

The Dashboard Maintenance Unit provides the user interface for Scenario Analysis 123 and

includes the required dashboard groups, components, data adapters, parameters and files.
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Home

The Home page contains Setup, Execute, and Analyze.

Scenario Analysis 123 is grouped into these sections:

* Setup: Establishes the creation and maintenance of scenario definitions, rule sets, and

rules.

* Execute: Contains execution and management of calculation jobs for scenario definitions.

* Analyze: Displays charts and pivot grids to view different scenario results.

[SCENARIO ANALYSIS 123

Scenario Analysis 123 Guide
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Settings

The Settings page contains the Global Options tab where you can set properties to determine

administration and uninstall options.

Global Options

Visit the Global Options page to start configuring Scenario Analysis 123.

I NOTE: All Global Options settings are retained during an upgrade.

SCENARIO ANALYSIS 123

Global Options

Uninstall Access & Manage Scenario Analysis: | Administrators - |

Analyze Results Row Limit: 50000

Access and Manage Scenario Analysis Security Role

Scenario Analysis 123 security is governed at the global level. Therefore, it is the assignment of
the user group to the security role that determines who will be the global Scenario Analysis 123

Administrators.

Assign User Group to Security Role

* Click Global Options, select the user group from the drop-down list (the default value is

Administrators), and click Save.
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Analyze Results Row Limit

Analyze Results Row Limit sets the maximum number of data rows that can be used to display
the charts and pivot grids on the Analyze page. The default value is 50,000 rows which can be

raised or lowered to account for server and client hardware-based performance limitations.

Global Options

Visit the Global Options page to start configuring Scenario Analysis 123.

I NOTE: All Global Options settings are retained during an upgrade.

SCENARIO ANALYSIS 123

Global Options

Uninstall Access & Manage Scenario Analysis: | Administrators - |

Analyze Results Row Limit: 50000

Access and Manage Scenario Analysis Security Role

Scenario Analysis 123 security is governed at the global level. Therefore, it is the assignment of
the user group to the security role that determines who will be the global Scenario Analysis 123

Administrators.

Assign User Group to Security Role

* Click Global Options, select the user group from the drop-down list (the default value is

Administrators), and click Save.
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Analyze Results Row Limit

Analyze Results Row Limit sets the maximum number of data rows that can be used to display
the charts and pivot grids on the Analyze page. The default value is 50,000 rows which can be

raised or lowered to account for server and client hardware-based performance limitations.

Global Options

Visit the Global Options page to start configuring Scenario Analysis 123.

I NOTE: All Global Options settings are retained during an upgrade.

SCENARIO ANALYSIS 123

Global Options

Uninstall Access & Manage Scenario Analysis: | Administrators - |

Analyze Results Row Limit: 50000

Access and Manage Scenario Analysis Security Role

Scenario Analysis 123 security is governed at the global level. Therefore, it is the assignment of
the user group to the security role that determines who will be the global Scenario Analysis 123

Administrators.

Assign User Group to Security Role

* Click Global Options, select the user group from the drop-down list (the default value is

Administrators), and click Save.
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Analyze Results Row Limit

Analyze Results Row Limit sets the maximum number of data rows that can be used to display
the charts and pivot grids on the Analyze page. The default value is 50,000 rows which can be

raised or lowered to account for server and client hardware-based performance limitations.

Uninstall

Uninstall lets you remove the user interface or the entire Scenario Analysis 123 solution. If

performed as part of an upgrade, any changes to standard Scenario Analysis 123 objects are lost.

There are two Uninstall options:

1. Uninstall Ul removes Scenario Analysis 123, including related dashboards and business
rules but leaves the database and related tables in place. For some releases, this step
should be performed before accepting any new version of Scenario Analysis 123 since

some of the Dashboards or other objects may have been modified.
* Choose this option to update without removing the data tables.
* The Scenario Analysis 123 Release Notes will indicate if an overinstall is supported.

2. Uninstall Full removes all the related data tables, all data, Scenario Analysis 123
dashboards, and business rules. Choose this option to remove Scenario Analysis 123 or to
perform an upgrade, so significant in its changes to the data tables, that this method is

required.

CAUTION: Uninstall procedures are irreversible.
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Setup

Setup lets you create and maintain rule sets, rules and definitions.

Definitions

Definitions consist of a Source and Target scenario for a cube. Rules sets and rules can be

created and applied to the Definition’s Target Scenario.

Name

Freeform text field to give definition a short name.

Description
Optional freeform text field containing additional definition information.

Target Scenario

The scenario to which the rules are applied.

Source Scenario

The scenario that will be copied to the Target scenario.

Cube
The Cube where the Source and Target scenarios are located.

Created By
The name of the user who created the definition.

Created Date

The date the definition was created.

Scenario Analysis 123 Guide

20



Setup

NOTE: Cube and Source scenarios are displayed based on the user’s security

access.
-0 H | Definitions ]
Mame ¥  Description ¥ | Target Scenario ¥ | Source Scenario ¥ | Cube ¥
2020 Mar - EMEA Adjustment 2020 Mar EMEA Plan Finance
2020 Mar - NA Adjustment 2020 Mar MA PlanAd) Finance

Click Create to create a Target scenario by copying all Dimension Library properties and settings,

including security settings, from the Source scenario in the same cube.

Create a Definition

TIP: Selecting a Scenario Type should be considered and based on business
requirements. A new Scenario Type can be used if your requirements do not require

all financial model rules to be attached to that Scenario Type.

1. Onthe Setup page, click Create.

2. Inthe Create Definition dialog, select the following:

Definition Name: Enter a display name to identify the definition.

* Definition Description: Enter an optional description for the definition.

Cube: Select the cube where the Source and Target scenarios reside.

* Source Scenario: Select the Source scenario to copy to the Target scenario.

Scenario Analysis 123 Guide 21
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Target Scenario Type: Select the new Target scenario type (defaults to the same type as

the selected Source scenario).

* Target Scenario Name: Enter the new Target scenario name where the rules will be

applied.
* Target Scenario Description: Enter an optional description for the new Target scenario.

* Select Copy All Rule Sets and Rules from Source to copy existing scenario analysis
definition rule sets and rules that exist for the source scenario. This will hot copy member

formulas and business rules.

3. Click Save.

IMPORTANT: The settings of the Source scenario and Target scenario must be the
same. For example, copying from a Source scenario using Range to a Target

scenario using Yearly is not recommended.
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[ ]
O

@ Create Definition
Definition Mame:

2020 Mar - N& Adjustment
Definition Description:

Adjustment for March, 2020.

Cube:
Finance
Source Scenario:

PlanAd)

Target Scenario Type:
Flan

Target Scenario Mame:
2020 Mar NA

Target Scenario Description:

Standard March, 2020

Copy All Rule Sets and Rules from Source: |i|

Cancel

Delete a Definition

1. Onthe Setup page, select the definition.

2. Select Delete Row(s).

3. Click Save.

Scenario Analysis 123 Guide
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NOTE: Deleting a definition does not delete the Target scenario created with the
definition. To delete a scenario, use the Dimension Library under Application.

Remove the scenario with a Data Management “Clear Data” job beforehand.

Definitions

Definitions consist of a Source and Target scenario for a cube. Rules sets and rules can be

created and applied to the Definition’s Target Scenario.

Name

Freeform text field to give definition a short name.

Description

Optional freeform text field containing additional definition information.

Target Scenario

The scenario to which the rules are applied.

Source Scenario

The scenario that will be copied to the Target scenario.

Cube

The Cube where the Source and Target scenarios are located.

Created By

The name of the user who created the definition.

Created Date

The date the definition was created.

NOTE: Cube and Source scenarios are displayed based on the user’s security

access.
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- O H |

Definitions

]

Mame Y  Description

2020 Mar - EMEA Adjustment

2020 Mar - NA Adjustment

T | Target Scenario ¥ | Source Scenario ¥ |Cube ¥

2020 Mar EMEA
2020 Mar MA

Plan

PlanAd)

Finance

Finance

Click Create to create a Target scenario by copying all Dimension Library properties and settings,

including security settings, from the Source scenario in the same cube.

Create a Definition

TIP: Selecting a Scenario Type should be considered and based on business

requirements. A new Scenario Type can be used if your requirements do not require

all financial model rules to be attached to that Scenario Type.

1. Onthe Setup page, click Create.

2. Inthe Create Definition dialog, select the following:

* Definition Name: Enter a display name to identify the definition.

* Definition Description: Enter an optional description for the definition.

* Cube: Select the cube where the Source and Target scenarios reside.

* Source Scenario: Select the Source scenario to copy to the Target scenario.

* Target Scenario Type: Select the new Target scenario type (defaults to the same type as

the selected Source scenario).

Scenario Analysis 123 Guide
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* Target Scenario Name: Enter the new Target scenario name where the rules will be

applied.
* Target Scenario Description: Enter an optional description for the new Target scenario.

* Select Copy All Rule Sets and Rules from Source to copy existing scenario analysis
definition rule sets and rules that exist for the source scenario. This will not copy member

formulas and business rules.

3. Click Save.

IMPORTANT: The settings of the Source scenario and Target scenario must be the
same. For example, copying from a Source scenario using Range to a Target

scenario using Yearly is not recommended.
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[ ]
O

@ Create Definition
Definition Mame:

2020 Mar - N& Adjustment
Definition Description:

Adjustment for March, 2020.

Cube:
Finance
Source Scenario:

PlanAd)

Target Scenario Type:
Flan

Target Scenario Mame:
2020 Mar NA

Target Scenario Description:

Standard March, 2020

Copy All Rule Sets and Rules from Source: |i|

Cancel

Delete a Definition

1. Onthe Setup page, select the definition.

2. Select Delete Row(s).

3. Click Save.
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NOTE: Deleting a definition does not delete the Target scenario created with the
definition. To delete a scenario, use the Dimension Library under Application.

Remove the scenario with a Data Management “Clear Data” job beforehand.

Definitions

Definitions consist of a Source and Target scenario for a cube. Rules sets and rules can be

created and applied to the Definition’s Target Scenario.

Name

Freeform text field to give definition a short name.

Description

Optional freeform text field containing additional definition information.

Target Scenario

The scenario to which the rules are applied.

Source Scenario

The scenario that will be copied to the Target scenario.

Cube

The Cube where the Source and Target scenarios are located.

Created By

The name of the user who created the definition.

Created Date

The date the definition was created.

NOTE: Cube and Source scenarios are displayed based on the user’s security

access.
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- O H |

Definitions

]

Mame Y  Description

2020 Mar - EMEA Adjustment

2020 Mar - NA Adjustment

T | Target Scenario ¥ | Source Scenario ¥ |Cube ¥

2020 Mar EMEA
2020 Mar MA

Plan

PlanAd)

Finance

Finance

Click Create to create a Target scenario by copying all Dimension Library properties and settings,

including security settings, from the Source scenario in the same cube.

Create a Definition

TIP: Selecting a Scenario Type should be considered and based on business

requirements. A new Scenario Type can be used if your requirements do not require

all financial model rules to be attached to that Scenario Type.

1. Onthe Setup page, click Create.

2. Inthe Create Definition dialog, select the following:

* Definition Name: Enter a display name to identify the definition.

* Definition Description: Enter an optional description for the definition.

* Cube: Select the cube where the Source and Target scenarios reside.

* Source Scenario: Select the Source scenario to copy to the Target scenario.

* Target Scenario Type: Select the new Target scenario type (defaults to the same type as

the selected Source scenario).
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* Target Scenario Name: Enter the new Target scenario name where the rules will be

applied.
* Target Scenario Description: Enter an optional description for the new Target scenario.

* Select Copy All Rule Sets and Rules from Source to copy existing scenario analysis
definition rule sets and rules that exist for the source scenario. This will not copy member

formulas and business rules.

3. Click Save.

IMPORTANT: The settings of the Source scenario and Target scenario must be the
same. For example, copying from a Source scenario using Range to a Target

scenario using Yearly is not recommended.
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[ ]
O

@ Create Definition
Definition Mame:

2020 Mar - N& Adjustment
Definition Description:

Adjustment for March, 2020.

Cube:
Finance
Source Scenario:

PlanAd)

Target Scenario Type:
Flan

Target Scenario Mame:
2020 Mar NA

Target Scenario Description:

Standard March, 2020

Copy All Rule Sets and Rules from Source: |i|

Cancel

Delete a Definition

1. Onthe Setup page, select the definition.

2. Select Delete Row(s).

3. Click Save.
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NOTE: Deleting a definition does not delete the Target scenario created with the
definition. To delete a scenario, use the Dimension Library under Application.

Remove the scenario with a Data Management “Clear Data” job beforehand.

Rule Sets

Rule sets are a collection of rules you can apply to the Target scenario definition.

Name
Freeform text field to give rule set a short name.

Description
Optional freeform text field containing additional rule set information.

Process Sequence
The order in which the Rule Sets are run. Rule Sets are run in ascending order of the process

sequence.

Active
Indicates if the rule set should be run during rule processing (on/off toggle).

Collapse Data
Collapses all data to the Import origin.

NOTE: Use Collapse Data if the scenario will be used in cube view forms to allow

form adjustment entry into the origins.
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Add a Rule Set

1. Onthe Setup page, select the definition.

2. Select Insert Row on the Rule Sets table header and then double-click these cells to enter

information:

Name
Enter a display name to identify the rule set.

Description
Enter an optional description for the rule set.

Process Sequence
Enter the sequence order for rule set processing.

3. Click Save.

Copy a Rule Set

You can copy arule set across definitions.
1. Onthe Setup page, select the definition.
2. Selectthe rule set you want to copy.
3. Select Copy Set.

4. Inthe Copy Rule Set dialog, add the new rule set name, a description and the target

definition.
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5. Click Copy.

() Copy Rule Set 0 o x
General Rules
Mew Rule 5et Mame:
Mew Rule Set
MNew Rule Set Description:

Description of new rule set,

Target Definition:

2020 Mar - NA Adjustment -

Cancel

Delete a Rule Set

1. Onthe Setup page, select the definition and rule set.
2. Select Delete Row(s).

3. Click Save.

Rule Sets

Rule sets are a collection of rules you can apply to the Target scenario definition.

Name
Freeform text field to give rule set a short name.

Description
Optional freeform text field containing additional rule set information.
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Process Sequence

The order in which the Rule Sets are run. Rule Sets are run in ascending order of the process

sequence.

Active

Indicates if the rule set should be run during rule processing (on/off toggle).

Collapse Data

Collapses all data to the Import origin.

NOTE: Use Collapse Data if the scenario will be used in cube view forms to allow

form adjustment entry into the origins.

Add a Rule Set

1. Onthe Setup page, select the definition.

2. Select Insert Row on the Rule Sets table header and then double-click these cells to enter

information:

Name
Enter a display name to identify the rule set.

Description
Enter an optional description for the rule set.

Process Sequence
Enter the sequence order for rule set processing.

3. Click Save.

Copy a Rule Set

You can copy a rule set across definitions.
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1. Onthe Setup page, select the definition.
2. Select the rule set you want to copy.
3. Select Copy Set.

4. Inthe Copy Rule Set dialog, add the new rule set name, a description and the target

definition.

5. Click Copy.

(]
O
X

@ Copy Rule Set

General Rules

Mew Rule et Mame:
MNew Rule Set

MNew Rule Set Description:

Description of new rule set.

Target Definition:

2020 Mar - NA Adjustment -

Cancel

Delete a Rule Set

1. Onthe Setup page, select the definition and rule set.
2. Select Delete Row(s).

3. Click Save.
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Rule Sets

Rule sets are a collection of rules you can apply to the Target scenario definition.

Name
Freeform text field to give rule set a short name.

Description
Optional freeform text field containing additional rule set information.

Process Sequence
The order in which the Rule Sets are run. Rule Sets are run in ascending order of the process

sequence.

Active
Indicates if the rule set should be run during rule processing (on/off toggle).

Collapse Data

Collapses all data to the Import origin.

NOTE: Use Collapse Data if the scenario will be used in cube view forms to allow

form adjustment entry into the origins.

Add a Rule Set

1. Onthe Setup page, select the definition.

2. SelectInsert Row on the Rule Sets table header and then double-click these cells to enter

information:

Name
Enter a display name to identify the rule set.
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Description
Enter an optional description for the rule set.

Process Sequence
Enter the sequence order for rule set processing.

3. Click Save.

Copy a Rule Set

You can copy arule set across definitions.
1. Onthe Setup page, select the definition.
2. Selectthe rule set you want to copy.
3. Select Copy Set.

4. Inthe Copy Rule Set dialog, add the new rule set name, a description and the target

definition.
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5. Click Copy.

() Copy Rule Set 0 o x
General Rules
Mew Rule 5et Mame:
Mew Rule Set
MNew Rule Set Description:

Description of new rule set,

Target Definition:

2020 Mar - NA Adjustment -

Cancel

Delete a Rule Set

1. Onthe Setup page, select the definition and rule set.
2. Select Delete Row(s).

3. Click Save.

Rule Sets

Rule sets are a collection of rules you can apply to the Target scenario definition.

Name
Freeform text field to give rule set a short name.

Description
Optional freeform text field containing additional rule set information.
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Process Sequence

The order in which the Rule Sets are run. Rule Sets are run in ascending order of the process

sequence.

Active

Indicates if the rule set should be run during rule processing (on/off toggle).

Collapse Data

Collapses all data to the Import origin.

NOTE: Use Collapse Data if the scenario will be used in cube view forms to allow

form adjustment entry into the origins.

Add a Rule Set

1. Onthe Setup page, select the definition.

2. Select Insert Row on the Rule Sets table header and then double-click these cells to enter

information:

Name
Enter a display name to identify the rule set.

Description
Enter an optional description for the rule set.

Process Sequence
Enter the sequence order for rule set processing.

3. Click Save.

Copy a Rule Set

You can copy a rule set across definitions.
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1. Onthe Setup page, select the definition.
2. Select the rule set you want to copy.
3. Select Copy Set.

4. Inthe Copy Rule Set dialog, add the new rule set name, a description and the target

definition.

5. Click Copy.

(]
O
X

@ Copy Rule Set

General Rules

Mew Rule et Mame:
MNew Rule Set

MNew Rule Set Description:

Description of new rule set.

Target Definition:

2020 Mar - NA Adjustment -

Cancel

Delete a Rule Set

1. Onthe Setup page, select the definition and rule set.
2. Select Delete Row(s).

3. Click Save.
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Rules

Rules are a collection of percentage values tied to a specific dimension and a time range for a

given definition rule set.

Name

Freeform text field to give the rule a name.

Description
Optional freeform text field containing additional rule information.

Process Sequence
The order in which the rules are run. Rules are run in ascending order of the process sequence

within each rule set.

NOTE: Consider how to sequence and process rules. Rules with broader to more

specific member filters should be sequenced in ascending order.

Active

Indicates if the rule should be run during rule processing (on/off toggle)

Dimensions (Entity — UD8)
The dimensions available where member filters can be applied for the definition.

Origin
There are three options for origin: Top, BeforeAdj, and Import.

NOTE: Each dimension field is freeform so a member filters can be applied to filter
data. Brackets are added to all member filters when applied to the formula in case a

dimension member has a space. Example: [New York]

See the Cube Member Filters section in the Design and Reference Guide for details.
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Periods (P1-P24)

Time periods 1through 24 where the rule numerical percentage values will be applied.

Add a Rule

1. Onthe Setup page, select the definition and rule set.

2. SelectInsert Row on the Rules table header and then double-click in these cells to enter

information:

Name
Enter a display name to identify the rule.

Description
Enter an optional description for the rule.

Process Sequence
Enter the sequence order for the rule processing.

Dimensions (Entity — UD8)
Enter the member filters for each dimension.

Periods (P1-P24)
Enter the percentage values for each period. Alternatively, the percentage value can be

entered in the % Value field for a percentage value to be applied to all periods.

3. Click Save.

The % Value field can be used to apply a percentage amount to all periods.

TIP: When creating a new definition, only the settings are copied from the Source
scenario to the Target scenario. If the data needs to be copied to the Target
scenario, apply an All or Root.Base member filter to each dimensionin a rule. For

example, A#Root.Base, A#ALL.
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Copy a Rule

You can copy arule to the same or another definition rule set.
1. Onthe Setup page, select the definition and rule set.

2.

w

4.

o

Select the rule to copy.

Select Copy Rule.

In the Copy Rule dialog, add the new rule name, an optional description, target definition

and target rule set.

Click Copy.

@ Copy Rule

Online Sales

MNew Rule Name:

Online Sales Rule

MNew Rule Description:

Target Definition:

Target Rule Set:

General Rules

[ ]
O

Online sales rule description.

2020 Mar - NA Adjustment

Cancel

-
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Delete a Rule

1. Onthe Setup page, select the definition and rule set.
2. Selecttherule.
3. Select Delete Row(s).

4. Click Save.

Apply a Formula to a Target Scenario

Oncerule sets and rules are created, the underlying member filters and percentage values can

be applied to the Target scenario member formula.

~ The Apply action adds the member filters and percentage values from each rule to the Target

scenario member formula.

I IMPORTANT: When changing rule sets or rules, click Apply to implement changes.

When the formula is applied the message, Formula Generated by Scenario Analysis 123 is added
to the Formula text along with the data and time stamp of update to the Target scenario member

formulain Member Properties.

Members | Dimension Properties | Grid View |

h i Members Member Properties | Relationship Properties
¥ [ Orphans UsE INPUL VIEW FUT AUJ 1 CEIcuiEnuns ralse
4 [ Hierarchy Mo Data Zero View For Adjustments Periodic
88 Mone Mo Data Zero View For NonAdjustments Periodic
22 Plan Consolidation View Periodic
B2 PlanAdj E__l%r_n_’l;.l_l_a _________________________________________ *---FORMULA GENERATED BY SCENA ...
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() Formula Editor - [PlanAdj]

Filter o | E 2|7 88| &
b G api 1 d |
24 "---FORMULA GENERATED BY SCEMARIO AMALYSIS 123 ON 5/1/282@ 2:18:51 PM (UTC) ---"
b @args a5 "Initialize Rule Values Data Table
~ . 1 Naim A+Doilac Ac Mo Diz+aTabhladl

Rules are a collection of percentage values tied to a specific dimension and a time range for a

given definition rule set.

Name

Freeform text field to give the rule a name.

Description

Optional freeform text field containing additional rule information.

Process Sequence
The order in which the rules are run. Rules are run in ascending order of the process sequence

within each rule set.

NOTE: Consider how to sequence and process rules. Rules with broader to more

specific member filters should be sequenced in ascending order.

Active
Indicates if the rule should be run during rule processing (on/off toggle)

Dimensions (Entity — UD8)

The dimensions available where member filters can be applied for the definition.
Origin

There are three options for origin: Top, BeforeAd], and Import.
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NOTE: Each dimension field is freeform so a member filters can be applied to filter
data. Brackets are added to all member filters when applied to the formula in case a

dimension member has a space. Example: [New York]

See the Cube Member Filters section in the Design and Reference Guide for details.

Periods (P1-P24)

Time periods 1through 24 where the rule numerical percentage values will be applied.

Add a Rule

1. Onthe Setup page, select the definition and rule set.

2. Select Insert Row on the Rules table header and then double-click in these cells to enter

information:

Name
Enter a display name to identify the rule.

Description
Enter an optional description for the rule.

Process Sequence
Enter the sequence order for the rule processing.

Dimensions (Entity — UD8)
Enter the member filters for each dimension.

Periods (P1-P24)

Enter the percentage values for each period. Alternatively, the percentage value can be

entered in the % Value field for a percentage value to be applied to all periods.

3. Click Save.

The % Value field can be used to apply a percentage amount to all periods.
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TIP: When creating a new definition, only the settings are copied from the Source
scenario to the Target scenario. If the data needs to be copied to the Target
scenario, apply an All or Root.Base member filter to each dimensionin a rule. For

example, A#Root.Base, A#ALL.

Copy a Rule

You can copy arule to the same or another definition rule set.
1. Onthe Setup page, select the definition and rule set.
2. Selectthe rule to copy.
3. Select Copy Rule.

4. Inthe Copy Rule dialog, add the new rule name, an optional description, target definition

and target rule set.
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5. Click Copy.

@ Copy Rule
Online Sales

Mew Rule Mame:
Online Sales Rule

MNew Rule Description:

Target Definition:
2020 Mar - NA Adjus
Target Rule Set:

General Rules

Online sales rule description.

tment

Cancel

-

Delete a Rule

1. Onthe Setup page, select the definition and rule set.

2. Selecttherule.

3. Select Delete Row(s).

4. Click Save.

Apply a Formula to a Target Scenario

Oncerule sets and rules are created, the underlying member filters and percentage values can

be applied to the Target scenario member formula.
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. The Apply action adds the member filters and percentage values from each rule to the Target

scenario member formula.

I IMPORTANT: When changing rule sets or rules, click Apply to implement changes.

When the formula is applied the message, Formula Generated by Scenario Analysis 123 is added
to the Formula text along with the data and time stamp of update to the Target scenario member

formula in Member Properties.

Members | Dimension Properties | Grid View |
» @ Members Member Properties | Relationship Properties
¥ [ Orphans Use INPUL VIEW FUT AUJ 1 CEICEnun raise
4- @ Hierarchy No Data Zero View For Adjustments Periodic
8a Mone Mo Data Zero View For NonAdjustments Periodic
22 Plan Consolidation View Periodic
82 PlanAdj Formula : "-—-FORMULA GENERATED BY SCENA ...

(1) Formula Editor - [PlanAdj]

Filter ® = | E 2| Y 88| &
> ﬂiapi 1 |
24 '---FORMULA GENERATED BY SCEMARIO AMALYSIS 123 ON 5/1/282@ 2:18:51 PM (UTC) ---"
> Gargs 25 'Initialize Rule Values Data Table
o e T4 Nim A+Dnlac A Maw NataTabladh

Rules

Rules are a collection of percentage values tied to a specific dimension and a time range for a

given definition rule set.

Name

Freeform text field to give the rule a name.

Scenario Analysis 123 Guide 50



Setup

Description

Optional freeform text field containing additional rule information.

Process Sequence
The order in which the rules are run. Rules are run in ascending order of the process sequence

within each rule set.

NOTE: Consider how to sequence and process rules. Rules with broader to more

specific member filters should be sequenced in ascending order.

Active

Indicates if the rule should be run during rule processing (on/off toggle)

Dimensions (Entity — UD8)
The dimensions available where member filters can be applied for the definition.
Origin

There are three options for origin: Top, BeforeAd;j, and Import.

NOTE: Each dimension field is freeform so a member filters can be applied to filter
data. Brackets are added to all member filters when applied to the formula in case a

dimension member has a space. Example: [New York]

See the Cube Member Filters section in the Design and Reference Guide for details.

Periods (P1-P24)

Time periods 1through 24 where the rule numerical percentage values will be applied.
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Add a Rule

1. Onthe Setup page, select the definition and rule set.

2. SelectInsert Row on the Rules table header and then double-click in these cells to enter

information:

Name
Enter a display name to identify the rule.

Description
Enter an optional description for the rule.

Process Sequence
Enter the sequence order for the rule processing.

Dimensions (Entity — UD8)
Enter the member filters for each dimension.

Periods (P1-P24)
Enter the percentage values for each period. Alternatively, the percentage value can be

entered in the % Value field for a percentage value to be applied to all periods.

3. Click Save.

The % Value field can be used to apply a percentage amount to all periods.

TIP: When creating a new definition, only the settings are copied from the Source
scenario to the Target scenario. If the data needs to be copied to the Target
scenario, apply an All or Root.Base member filter to each dimensionin a rule. For

example, A#Root.Base, A#ALL.

Copy a Rule

You can copy arule to the same or another definition rule set.
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1. Onthe Setup page, select the definition and rule set.

2.

o

Select the rule to copy.

Select Copy Rule.

In the Copy Rule dialog, add the new rule name, an optional description, target definition

and target rule set.

Click Copy.

@ Copy Rule

Online Sales

MNew Rule Mame:

Online Sales Rule

MNew Rule Description:

Target Definition:

Target Rule Set:

General Rules

(]
O
X

Online sales rule description.

2020 Mar - NA Adjustment

Cancel

-

Delete a Rule

1. Onthe Setup page, select the definition and rule set.

2. Selecttherule.
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3. Select Delete Row(s).

4. Click Save.

Apply a Formula to a Target Scenario

Once rule sets and rules are created, the underlying member filters and percentage values can

be applied to the Target scenario member formula.

~ The Apply action adds the member filters and percentage values from each rule to the Target

scenario member formula.

I IMPORTANT: When changing rule sets or rules, click Apply to implement changes.

When the formula is applied the message, Formula Generated by Scenario Analysis 123 is added

to the Formula text along with the data and time stamp of update to the Target scenario member

formulain Member Properties.

Members | Dimension Properties | Grid View |

» [ Members

» [ Orphans

4 [ Hierarchy
22 None
22 Plan

B4 PlanAdj

Member Properties | Relationship Properties

USEITIRUL WIZW FUn AL LdILulgununs False

Mo Data Zero View For Adjustments Periodic

Mo Data Zero View For NonAdjustments Periodic

Consolidation View Periodic

FDrmuIa _________________________________________ ' '---FORMULA GENERATED BY SCEMA ...

() Formula Editor - [PlanAdj]

Filter
b G api
b G@args

21 ¥ 8|+

P
1+
i

] |

24 ' ---FORMULA GENERATED BY SCENARIO ANALYSIS 123 ON 5/1/2020 2:1@:51 PM (UTC) ---"

*Initialize Rule Values Data Table
Nim A+Dilac Ac Baw Nat+aTahlalh
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Rules

Rules are a collection of percentage values tied to a specific dimension and a time range for a

given definition rule set.

Name

Freeform text field to give the rule a name.

Description
Optional freeform text field containing additional rule information.

Process Sequence
The order in which the rules are run. Rules are run in ascending order of the process sequence

within each rule set.

NOTE: Consider how to sequence and process rules. Rules with broader to more

specific member filters should be sequenced in ascending order.

Active

Indicates if the rule should be run during rule processing (on/off toggle)

Dimensions (Entity — UD8)
The dimensions available where member filters can be applied for the definition.

Origin
There are three options for origin: Top, BeforeAdj, and Import.

NOTE: Each dimension field is freeform so a member filters can be applied to filter
data. Brackets are added to all member filters when applied to the formula in case a

dimension member has a space. Example: [New York]

See the Cube Member Filters section in the Design and Reference Guide for details.
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Periods (P1-P24)

Time periods 1through 24 where the rule numerical percentage values will be applied.

Add a Rule

1. Onthe Setup page, select the definition and rule set.

2. SelectInsert Row on the Rules table header and then double-click in these cells to enter

information:

Name
Enter a display name to identify the rule.

Description
Enter an optional description for the rule.

Process Sequence
Enter the sequence order for the rule processing.

Dimensions (Entity — UD8)
Enter the member filters for each dimension.

Periods (P1-P24)
Enter the percentage values for each period. Alternatively, the percentage value can be

entered in the % Value field for a percentage value to be applied to all periods.

3. Click Save.

The % Value field can be used to apply a percentage amount to all periods.

TIP: When creating a new definition, only the settings are copied from the Source
scenario to the Target scenario. If the data needs to be copied to the Target
scenario, apply an All or Root.Base member filter to each dimensionin a rule. For

example, A#Root.Base, A#ALL.
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Copy a Rule
You can copy arule to the same or another definition rule set.
1. Onthe Setup page, select the definition and rule set.

2. Selectthe rule to copy.

w

Select Copy Rule.

4. Inthe Copy Rule dialog, add the new rule name, an optional description, target definition

and target rule set.

o

Click Copy.

(]
a
x

@ Copy Rule

Cnline Sales

Mew Rule Mame:
Online Sales Rule

MNew Rule Description:

Online sales rule description.

Target Definition:
2020 Mar - NA Adjustment -
Target Rule Set:

General Rules T

Cancel
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Delete a Rule

1. Onthe Setup page, select the definition and rule set.
2. Selecttherule.
3. Select Delete Row(s).

4. Click Save.

Apply a Formula to a Target Scenario

Oncerule sets and rules are created, the underlying member filters and percentage values can

be applied to the Target scenario member formula.

~ The Apply action adds the member filters and percentage values from each rule to the Target

scenario member formula.

I IMPORTANT: When changing rule sets or rules, click Apply to implement changes.

When the formula is applied the message, Formula Generated by Scenario Analysis 123 is added
to the Formula text along with the data and time stamp of update to the Target scenario member

formulain Member Properties.

Members | Dimension Properties | Grid View |

h i Members Member Properties | Relationship Properties
¥ [ Orphans UsE INPUL VIEW FUT AUJ 1 CEIcuiEnuns ralse
4 [ Hierarchy Mo Data Zero View For Adjustments Periodic
88 Mone Mo Data Zero View For NonAdjustments Periodic
22 Plan Consolidation View Periodic
B2 PlanAdj E__l%r_n_’l;.l_l_a _________________________________________ *---FORMULA GENERATED BY SCENA ...
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() Formula Editor - [PlanAdj]

Filter o | E 2|7 88| &
b G api 1 d |
24 "---FORMULA GENERATED BY SCEMARIO AMALYSIS 123 ON 5/1/282@ 2:18:51 PM (UTC) ---"
b @args a5 "Initialize Rule Values Data Table
~ . 1 Naim A+Doilac Ac Mo Diz+aTabhladl

Rules are a collection of percentage values tied to a specific dimension and a time range for a

given definition rule set.

Name

Freeform text field to give the rule a name.

Description

Optional freeform text field containing additional rule information.

Process Sequence
The order in which the rules are run. Rules are run in ascending order of the process sequence

within each rule set.

NOTE: Consider how to sequence and process rules. Rules with broader to more

specific member filters should be sequenced in ascending order.

Active
Indicates if the rule should be run during rule processing (on/off toggle)

Dimensions (Entity — UD8)

The dimensions available where member filters can be applied for the definition.
Origin

There are three options for origin: Top, BeforeAd], and Import.
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NOTE: Each dimension field is freeform so a member filters can be applied to filter
data. Brackets are added to all member filters when applied to the formula in case a

dimension member has a space. Example: [New York]

See the Cube Member Filters section in the Design and Reference Guide for details.

Periods (P1-P24)

Time periods 1through 24 where the rule numerical percentage values will be applied.

Add a Rule

1. Onthe Setup page, select the definition and rule set.

2. Select Insert Row on the Rules table header and then double-click in these cells to enter

information:

Name
Enter a display name to identify the rule.

Description
Enter an optional description for the rule.

Process Sequence
Enter the sequence order for the rule processing.

Dimensions (Entity — UD8)
Enter the member filters for each dimension.

Periods (P1-P24)

Enter the percentage values for each period. Alternatively, the percentage value can be

entered in the % Value field for a percentage value to be applied to all periods.

3. Click Save.

The % Value field can be used to apply a percentage amount to all periods.
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TIP: When creating a new definition, only the settings are copied from the Source
scenario to the Target scenario. If the data needs to be copied to the Target
scenario, apply an All or Root.Base member filter to each dimensionin a rule. For

example, A#Root.Base, A#ALL.

Copy a Rule

You can copy arule to the same or another definition rule set.
1. Onthe Setup page, select the definition and rule set.
2. Selectthe rule to copy.
3. Select Copy Rule.

4. Inthe Copy Rule dialog, add the new rule name, an optional description, target definition

and target rule set.
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5. Click Copy.

() Copy Rule R
Online Sales
Mew Rule Mame:
Cnline Sales Rule
MNew Rule Description:

Online sales rule description.

Target Definition:
2020 Mar - NA Adjustment -
Target Rule Set:

General Rules T

Cancel

Delete a Rule

1. Onthe Setup page, select the definition and rule set.
2. Selecttherule.
3. Select Delete Row(s).

4. Click Save.

Apply a Formula to a Target Scenario

Oncerule sets and rules are created, the underlying member filters and percentage values can

be applied to the Target scenario member formula.
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. The Apply action adds the member filters and percentage values from each rule to the Target

scenario member formula.

I IMPORTANT: When changing rule sets or rules, click Apply to implement changes.

When the formula is applied the message, Formula Generated by Scenario Analysis 123 is added

to the Formula text along with the data and time stamp of update to the Target scenario member

formula in Member Properties.

Members | Dimension Properties | Grid View |

»— B Members

» [ Orphans

4 [g Hierarchy
22 None
28 Plan

24 PlanAdj

Member Properties | Relationship Properties

USEITIPUL WIEW FUT AL T LdILulEanons Falise
Mo Data Zero View For Adjustments Periodic
Mo Data Zero View For NonAdjustments Periodic
Consolidation View Periodic
‘Formula  *---FORMULA GENERATED BY SCENA ...

(1) Formula Editor - [PlanAdj]

Filter ® = | E 2| YV 88| &
> ﬂiapi 1 |
24 '---FORMULA GENERATED BY SCEMARIO AMALYSIS 123 ON 5/1/282@ 2:18:51 PM (UTC) ---"
> Gargs 25 'Initialize Rule Values Data Table
o e T4 Nim A+Dnlac A Maw NataTabladh

Scenario Analysis 123 Guide 63



Execute

Execute

* Execute lets you manage and run calculation jobs for scenarios.

Calculation Jobs

Calculation jobs let you execute a Force Consolidate or Force Calculate data management job for

a defined set of data in a definition scenario.

& & >
Setup Analyze Run
Definitions E| =D H| Calculation Jobs - 2020 NA Sales Forecast v1
Name Y | Description ¥ | Target Scenario Y | source Scenario ¥ | Cube ¥ | Createo| ||Entity ¥ cons ¥ cCalculation Type T | Start Period ¥ Periods V| Created By ¥ Created Date A
2020 A Sales Forecast vi 2020 NA Sales Forecast v1 Actual Houston Admin || TotGroup.Base  Local 2019M1 1 Admin 5/4/2020 4:19:40 PM
2020 South Region Sales Forecast v1 2020 South Region Sales Forecast v1 | Plan Houston | Admin
Entity

Where a member filter can be applied to execute the calculation job for a specific entity.

Cons
Where a member filter can be applied to execute the calculation job by a specific consolidation

type.

Calculation Type
The type of calculation, Force Consolidate or Force Calculate.

NOTE: Consider the level in the Entity hierarchy. Each calculation job should only
Force Consolidate or Force Calculate for the relevant data set required. For
example, use Force Calculate when there are no parent members, all base, or just

one base entity.
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Start Period

The starting period for the calculation job.

Periods

The number of periods the calculation job should be executed.

Create a Calculation Job

1. Onthe Execute page, select the definition.

2. Select Insert Row on the Calculation Jobs table header and then double-click in these cells

to enter information:

Entity
Enter the member filters for the Entity dimension.

Cons
Enter the consolidation type

Calculation Type
Select the calculation type of Force Consolidate or Force Calculate.

Start Period
Enter the starting period for the calculation job.

Periods
Select the number of periods the calculation job should be executed.

3. Click Save.

* Runs the selected calculation data management job.

NOTE: Make performance considerations before executing calculation data

management jobs against large metadata hierarchies.
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Calculation Jobs

Calculation jobs let you execute a Force Consolidate or Force Calculate data management job for

a defined set of data in a definition scenario.

B B >
Setup Analyze Run
Definitions Bl = O H | Calculation Jobs - 2020 NA Sales Forecast v1
Name Y | Description ¥ | Target Scenario Y | source Scenario ¥ | Cube ¥ | Createo| ||Entity ¥ cons ¥ cCalculation Type T | Start Period ¥ Periods V| Created By ¥ Created Date T
020 A Sales Forecast vi 2020 NA Sales Forecast v1 Actual Houston Admin || TotGroup.Base  Local 2019M1 1 Admin 5/4/2020 4:19:40 PM
2020 South Region Sales Forecast v1 2020 South Region Sales Forecastv1 | Plan Houston | Admin
Entity

Where a member filter can be applied to execute the calculation job for a specific entity.

Cons
Where a member filter can be applied to execute the calculation job by a specific consolidation

type.

Calculation Type

The type of calculation, Force Consolidate or Force Calculate.

NOTE: Consider the level in the Entity hierarchy. Each calculation job should only
Force Consolidate or Force Calculate for the relevant data set required. For
example, use Force Calculate when there are no parent members, all base, or just

one base entity.

Start Period

The starting period for the calculation job.

Periods
The number of periods the calculation job should be executed.
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Create a Calculation Job

1. Onthe Execute page, select the definition.

2. Select Insert Row on the Calculation Jobs table header and then double-click in these cells

to enter information:

Entity
Enter the member filters for the Entity dimension.

Cons
Enter the consolidation type

Calculation Type
Select the calculation type of Force Consolidate or Force Calculate.

Start Period
Enter the starting period for the calculation job.

Periods
Select the number of periods the calculation job should be executed.

3. Click Save.

Runs the selected calculation data management job.

NOTE: Make performance considerations before executing calculation data

management jobs against large metadata hierarchies.
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Analyze

2 Contains charts and pivot grids to view and analyze different scenarios.

Filters

The View and Pivot results are returned when you specify the header filters.

Definition:

2020 NA Sales Forecast vl

-

Entity: Account:

TotGroup TotalRevenues

Start Period:

2019M1

-

Periods:

12

-

View:

Periodic

C

Refresh

View

Provides a chart and grid so you can analyze variances between source and target scenarios.

Additional Time, Entity, and Account filters are provided.

SCENARIO ANALYSIS 123 k#
LI
a2 De Entity: Accourt: Percds View: >
B B & B . Cc
Setup Execute Wiew Pivot o Ftceup e o d Refresh
[ — i
[ ™ wan 2 - Wsource W Terget
i 2020M01 215K \\
[v] 2020m02 -~
) 2020003 21 /
v] 2020m04 &
= 205K
[v] 2020m05
fsrn " ™
B IRIE
¥ entoor i
v enooz
sk
1eK
sk
earch 2020M01 2020M02 2020M03 2020004 2020m05 2020M06 2020M0T 2020m08 2020M09 2020M10 2000M11 2020M12 2021M01 2021m02
| & an ‘
] Onlnesales =
o — . | vatiance
2 |:| |:| D
Zo20m01 2020002 2020m03 wowoe [avaouss 000006 2020007 maovos  [aowos  [soaowio[oaowny 202012 220t oo
T 17,10000 1800000 1780000 2050000 1870000 1860000 2130000 2170000 200000 2010000 1810000 17,6000 18.00000 1800000
Grand Tatal Target 1922895 18,180.00 1841580 1866690 1975455 1783575 1927395 1907190 1868490 1857645 1908450 1822095 18,088.65 1905570
Variance + 152895 4 18000 4 615204 1833104 105455 9 176425 % 2026054 2628104 3315104 152355 4 98450 52095 4+ 8865 105570
PELEEERETEE  plan Submission.  New
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Pivot

 Provides a pivot grid where you can filter scenario data for a more granular analysis.

ANALYZE
2 Defiition Entity: Account: StrtPeriod:  Periods: View
& [® s O
stp  Bewte | vew sy |PlontoPlanidi - TotGroup Total Revenues 2020M1  w|[12 || periodic ~ .
H 7l
|5 Hidden Fields MH- 2020M01 ‘zozuMuz ‘zozoMoz ‘zoszM
Cons. 7 Source Target Variance ‘Snurce Target Variance ‘Suurce Target Variance ‘Suurce Target
Cube Onlinesales. 1,500.00 1,600.95 -100.95 1,500.00 1,560.00 -60.00 1,500.00 1,613.40 -113.40 1,500.00
4 ENTOO1
Flow Sales 4,500.00 4,308.70 -308.70 4,500.00 4576.50 -76.50 4,500.00 452520 -25.20 4,500.00
S ENTOO1 Total 6,000.00 6,409.65 -400.65 6,000.00 6,136.50 13650 6,000.00 6,138.60 -138.60 6,000.00
Origin
Onlinesales 3,000.00 3,201.90 -201.90 3,000.00 3,120.00 -12000 3,000.00 3,226.80 -226.80 3,000.00
Parent ~|| 4 entooz
. Sales 9,000.00 9,617.40 -617.40 9,000.00 9,153.00 -152.00 9,00000 9,05040 -5040 9,000.00
T Fitter Area TE Column Area | £nTo02 Total 12,000.00 12,819.30 -819.30 12,000.00 12,273.00 -273.00 12,000.00 12,277.20 -277.20 12,000.00
Time - ; 1
Grand Total 18,00000 | 19,228.95 -1,22895 18,000.00 18,409.50 -409.50 18,00000 18,415.80 -415.80 18,000.00
|2 Row Area 3 Data Area
Entity - ‘ Source
Account || |[Target
Variance
| | Defer Layout Update . N
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Help & Miscellaneous Information

» This page contains additional solution documentation for Scenario Analysis.

Display Settings

OneStream Solutions frequently display multiple data elements for data entry and analysis. Set

your screen resolution to a minimum of 1920 x 1080 to best render forms and reports.

Package Contents & Naming Conventions

The package file name contains multiple identifiers that correspond with the platform. Renaming
any of the elements contained in a package is discouraged in order to preserve the integrity of

the naming conventions.

Example Package Name: SAM_PV5.3.0_SV100_PackageContents.zip

Identifier Description

SAM Solution ID

PV5.3.0 Minimum Platform version required to run solution
SV100 Solution version

PackageContents File name
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Solution Database Migration Advice

A development OneStream application is the safest method for building out a solution with
custom tables such as this one. The relationship between OneStream objects such as workflow
profiles and custom solution tables is that they point to the underlying identifier numbers and not
the object names as seen in the user interface. Prior to the solution configuration and to ensure
the identifiers match within the development and production applications, the development
application should be arecent copy of the production application. Once the development
application is created, install the solution and begin design. The following process below will help

migrate the solution tables properly.

See also: Managing a OneStream Environment in the Design and Reference Guide.

1. Inthe production OneStream application, install the solution and create the data tables.

See Configure the OneStream Application Server for Database Server Connection settings

and installation details.

2. Datatables are created in the OneStream Development application during the solution
installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to

the Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator

should run the migration assistant.

IMPORTANT: This process may overwrite existing table data in the production

application database if data already exists.

OneStream SolutionModification

Considerations

A few cautions and considerations regarding the modification of OneStream Solutions:
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Help & Miscellaneous Information

* Major changes to business rules or custom tables within a OneStream Solution will not be
supported through normal channels as the resulting solution is significantly different from

the core solution.

* If changes are made to any dashboard object or business rule, consider renaming it or
copying itto a new object first. This is important because if there is an upgrade to the
OneStream Solution in the future and the customer applies the upgrade, this will overlay
and wipe out the changes. This also applies when updating any of the standard reports

and dashboards.

* [f modifications are made to a OneStream Solution, upgrading to later versions will be more
complex depending on the degree of customization. Simple changes such as changing a
logo or colors on a dashboard do not impact upgrades significantly. Making changes to the
custom database tables and business rules, which should be avoided, will make an

upgrade even more complicated.
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Appendix A: Custom Event Model

The Custom Event model enables you to add customizations to Scenario Analysis 123 that are

retained during an upgrade. Scenario Analysis 123 supports these models using business rules.

Set Up the Custom Event Model

1. Onthe Application tab click Dashboards > Dashboard Maintenance Units > XFW
Scenario Analysis 123 (SAM) > Files.

2. InFiles, click CustomEventHandler_SAM.zip.

4 [ XFPW Scenario Analysis 123 (SAM)

¥ Dashboard Groups

» Components

# Data Adapters

» Parameters

4 Files
Add_SAM.png
Analyze130_SAM.png
Analyze50_SAM.png
AnalyzePivot_SAM.png
AnalyzeViewer_SAM.png
Apply_SAM.png
Copy_SAM.png
CreateTables48_SAMS.png
CustomEventHandler_SAM.zip
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3. Inthe General (File) pane, click Download File and save the file to an appropriate location.
4. On Application, click Tools > Load/Extract.

5. OnLoad, locate CustomEventHandler_SAM.zip using the Select File icons and click

Open.

6. When the file name appears, click Load to import the business rule.

Integrate Business Rules

After importing the business rule, update the SAM_EventHandler business rule to integrate with

the CustomEvents business rule.

1. Inthe General section of the SAM_SolutionHelper script Properties tab, add

BR\CustomEvents_ScenarioAnalysisi23 to Referenced Assemblies.

Properties Formula

B General
MName SAM_SolutionHelper
Type Dashboard Extender
ReferencedAssemblles BR\SAM _EventHandler; BR\CustomEvents_Scenario&nalysis123
Is Encrypted True
B Security
Access Group Everyone
Maintenance Group Everyone

2. Inthe General section of the SAM_EventHandler script Properties tab, add

BR\CustomEvents_ScenarioAnalysis123 to Referenced Assembilies.
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Properties | Formula

B General
Mame SAM_EventHandler
Type Dashboard Extender
Reeencad et o utomients ScenaroAnaysstz
Is Encrypted False
B Security
Access Group Everyone
Maintenance Group Everyone

3. Comment out line 42 of the SAM_EventHelper business rule.

4. Uncomment line 43 of the SAM_EventHelper business rule.

41 "Custom Event Handler Declaration
42 Public Property m_CustomEvents As Object = Nothing
43 "Public Property m_CustomEvents As Mew DashboardExtender.CustomEvents_ScenariocAnalysis.MainClass

Once the custom event integration is complete, event actions can be defined in the

CustomEvents_ScenarioAnalysis123 script.

NOTE: These events are not deleted or overriden in an upgrade. However, reapply

these setup steps every time a new version is installed.

Available Custom Events

Before/After Selection Changed Events

These events run before/after a custom control is clicked:

Scenario Analysis 123 Guide 75



Appendix A: Custom Event Model

* SaveSettings

* CreateSolutionTables

* ValidateSetupStepsExecuted
¢ Uninstall

* OnTableEditorOrGridSelection
* OnComboBoxSelection

* OnButtonClick

* OnShowContentPage

Before/After Save Data Events

These events run before/after the save event for a table editor. For example, this can be used to

test grid data prior to saving and potentially not allowing the data to be saved if a check fails.

* OnSaveOrUpdateTableEditor

Available Custom Events

Before/After Selection Changed Events
These events run before/after a custom control is clicked:
* SaveSettings

¢ CreateSolutionTables
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* ValidateSetupStepsExecuted
* Uninstall

¢ OnTableEditorOrGridSelection
* OnComboBoxSelection

* OnButtonClick

* OnShowContentPage

Before/After Save Data Events

These events run before/after the save event for a table editor. For example, this can be used to

test grid data prior to saving and potentially not allowing the data to be saved if a check fails.

* OnSaveOrUpdateTableEditor

Available Custom Events

Before/After Selection Changed Events
These events run before/after a custom control is clicked:
* SaveSettings

¢ CreateSolutionTables

ValidateSetupStepsExecuted

¢ Uninstall
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e OnTableEditorOrGridSelection
¢ OnComboBoxSelection
¢ OnButtonClick

* OnShowContentPage

Before/After Save Data Events

These events run before/after the save event for a table editor. For example, this can be used to

test grid data prior to saving and potentially not allowing the data to be saved if a check fails.

* OnSaveOrUpdateTableEditor
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